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[image: image1.png]



5. Смоделировать в 3d модель собственного мобильного телефона.
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СПИСОК УСЛОВНЫХ СОКРАЩЕНИЙ

ПК – персональный компьютер;
СК – система координат;
РГР – расчетно-графическая работа;
САПР – система автоматизации проектных работ;
CAD - Computer-Aided Design;
ВВЕДЕНИЕ

Актуальность темы. На данном этапе развития человечества разработано очень много новых полезных решений различных задач, введение новшеств и модернизации. Одним из таких новшеств  является использование разработанных САПР для создания 3D-моделей, которое в данный момент применяются по всюду. 3D-моделирование используется для проектирования масштабных строительных объектов (жилые дома, торговые и бизнес центры, ландшафтные зоны).
Цели и задачи работы. Целями данной работы является изучение всех возможностей САПР, к которым относятся AutoCAD, для создания 2D и  3D модели детали с выполнением разреза.
Практическое значение. 3D-графика давно применяется в киноиндустрии и в теле-оформлении, но немногие знают насколько серьезно использование 3D-моделирования, например, в архитектуре или проектировании. 3D-моделирование позволяет создать практически любую виртуальную среду и ее объекты. Использование 3D модели позволяет изучить, еще до того как они созданы в реале. Трехмерную модель можно осмотреть, вращать, измерить ее свойства. Для того чтобы создать качественную 3D-модель необходимо собрать максимум информации о моделируемом объекте, минимум необходимым фотографиям с разных ракурсов. Полученная информация приходиться в соответствии, затем создаются двухмерные проекции объекты, а уже потом строятся поверхности.

Большое количество примеров, которые можно привести для внедрения технологии создания цифровых объемных топографических карт, они применяются в различных науках и технике.

Структура работы. Работа состоит из введения, двух разделов, пояснительной записки, заключения, литературы.
РАЗДЕЛ 1 
ОБЗОР СРЕДСТВ СОЗДАНИЯ И РЕДАКТИРОВАНИЯ КОМПЬЮТЕРНОЙ ГРАФИКИ
1.1. САПР системы

Программный пакет, предназначенный для создания чертежей, конструкторской и/или технологической документации и/или 3D моделей. Современные системы автоматизированного проектирования обычно используются совместно с системами автоматизации инженерных расчётов и анализа CAE. Данные из CAD-систем передаются в CAM (англ. Computer-aided manufacturing — система автоматизированной разработки программ обработки деталей для станков с ЧПУ или ГАПС (Гибких автоматизированных производственных систем)).
Обычно охватывает создание геометрических моделей изделия (твердотельных, трехмерных, составных), а также генерацию чертежей изделия и их сопровождение. Следует отметить, что русский термин «САПР» по отношению к промышленным системам имеет более широкое толкование, чем «CAD» — он включает в себя CAD, CAM и CAE.
1.1.1. CATIA
CATIA — система автоматизированного проектирования (САПР) французской фирмы Dassault Systèmes. CATIA V1 была анонсировна в 1981 году.
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Рис. 1.1.  Интерфейс САПР CATIA
В настоящий момент в мире используются две версии — V4 и V5, которые значительно отличаются между собой. CATIA V4 была анонсирована в 1993 году и создавалась для Unix-подобных операционных систем, CATIA V5 была анонсирована в 1998 году и это первая из версий, которая может работать под управлением Microsoft Windows. По заверению Dassault Systèmes CATIA V5 была написана с «нуля» и воплотила в себе передовые технологии САПР конца XX века — начала XXI века.
В первое время CATIA V5 не пользовалась особой популярностью на рынке, и, чтобы стимулировать переход с V4 на V5, Dassault Systèmes выдвинула концепцию PLM (Product Lifecycle Management). Идея PLM оказалась удачной, и её подхватила почти вся индустрия САПР.
В феврале 2008 Dassault Systèmes анонсировала новую версию системы — CATIA V6. V6 будет поддерживать программы моделирования для всех инженерных дисциплин и коллективные бизнес-процессы на протяжении жизненного цикла изделия. Новая концепция фирмы получила название «PLM 2.0 на платформе V6». Суть концепции — трёхмерное моделирование (3D) и коллективная работа в реальном времени. Для связи между людьми, находящимися в разных точках мира, предусмотрены средства простого подключения к Web.
В PLM-решение V6 войдут системы CATIA для автоматизации проектирования, ENOVIA для управления инженерными данными и коллективной работы, SIMULIA для инженерного анализа и DELMIA для цифрового производства.
Решения PLM V6 для малого и среднего бизнеса (SMB) разрабатываются израильским филиалом фирмы Dassault Systèmes Israel (SMARTEAM).
Основными конкурентами являются NX от Siemens PLM Software и Pro/ENGINEER от Parametric Technology Corporation.
Системные требования: Pentium 4 и выше, 2Gb RAM, 3D-видеокарта 64 Мб. Разрешение экрана: 1280х1024. Размер дистрибутива: все вместе ~6,6 Gb. Стоимость лицензии $14 795.
1.1.2. САПР Компас

КОМПАС — система автоматизированного проектирования, разработанная российской компанией «АСКОН» с возможностями оформления проектной и конструкторской документации согласно стандартам серии ЕСКД и СПДС.

Существует в двух версиях: КОМПАС-График и КОМПАС-3D, соответственно предназначенных для плоского черчения и трёхмерного проектирования.

КОМПАС-График может использоваться как полностью интегрированный в КОМПАС-3D модуль работы с чертежами и эскизами, так и в качестве самостоятельного продукта, полностью закрывающего задачи 2D-проектирования и выпуска документации.
Система ориентирована на поддержку стандартов ЕСКД и СПДС. КОМПАС-График автоматически генерирует ассоциативные виды трёхмерных моделей (в том числе разрезы, сечения, местные разрезы, местные виды, виды по стрелке, виды с разрывом). Все они ассоциированы с моделью: изменения в модели приводят к изменению изображения на чертеже.
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Рис. 1.2.  Интерфейс САПР Компас
Стандартные виды автоматически строятся в проекционной связи. Данные в основной надписи чертежа (обозначение, наименование, масса) синхронизируются с данными из трёхмерной модели.
Существует большое количество дополнительных библиотек к системе КОМПАС, автоматизирующих различные специализированные задачи. Например, библиотека стандартных изделий позволяет добавлять уже готовые стандартные детали в трехмерные сборки (крепежные изделия, подшипники, элементы трубопроводов, шпонки, уплотнения), а также графические обозначения стандартных элементов на чертежи (обозначения отверстий), предоставляя возможность задания их параметров.
Системные требования: процессор Pentium III с тактовой частотой 800 МГц; оперативная память 512 Мб; графический адаптер SVGA с видеопамятью 32 Мб; привод DVD-ROM; свободное пространство на жестком диске не менее 500 Мб; манипулятор "мышь". Стоимость лицензии 90 000 р.
1.1.3. SolidWorks

SolidWorks — система автоматизации проектных работ (САПР) в трёх измерениях, работает под управлением Microsoft Windows. Разработана компанией SolidWorks Corporation в качестве альтернативы двухмерным САПР.

Приобрела популярность благодаря простому интерфейсу пользователя. Система работает на основе геометрического ядра Parasolid.
Главная задача программы — предоставить пользователю мощность трёхмерной САПР системы по цене системы двухмерного САПР.
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Рис. 1.3. Интерфейс САПР SolidWorks
SolidWorks распространяется в трех коммерческих и трех образовательных вариантах:
1. Коммерческие:
· SolidWorks Mechanical

· SolidWorks Office Professional

· SolidWorks Office Premium

2. Образовательные:
· SolidWorks Student Design Kit

· SolidWorks Education Edition

· SolidWorks Student Edition

Основной продукт SolidWorks включает инструменты для трехмерного моделирования, создания сборок, чертежей, работы с листовым металлом, сварными конструкциям и поверхностями произвольной формы. Присутствует возможность импортирования большого числа файлов 2D и 3D CAD программ. Имеется API для программирования в среде Visual Basic и C. Также включена программа для анализа методом конечных элементов начального уровня CosmosXpress.
Минимальные системные требования: Операционная система: Windows XP/Vista; Процессор: Pentium 4 2.8 ГГц; Память: 512 МБ; Свободное место на ЖД: 5.5 ГБ. Стоимость лицензии 8400$.
ВЫВОДЫ РАЗДЕЛА 1
Среди систем малого и среднего класса в мире наиболее популярна система AutoCad. Так же существуют такие САПР как CATIA (разработанная во Франции) и Компас (относящийся к Российским программам), но они не достигли широкого распространения.
РАЗДЕЛ 2
РЕАЛИЗАЦИЯ 3D МОДЕЛИРОВАНИЯ В СРЕДЕ AUTOCAD

2.1. Присвоение атрибутов в AutoCad.
Чертежи существуют не в вакууме. Объекты на чертежах вполне реальны. Они обладают многими характеристиками, которые нельзя наглядно представить на чертеже, например фирма-изготовитель, дата приобретения и т.д. Эти сведения могут храниться в отдельной базе данных. Однако существует более удобный способ: используя атрибуты, данные о чертеже можно связать с блоками (атрибуты — это надписи, подключенные к блокам). Данные атрибутов можно извлечь и экспортировать в программу управления базой данных или электронными таблицами.

Кроме того, есть возможность получить доступ к внешней базе данных или вставить ссылку на нее. Кроме того, данные можно получать из объектов, не являющихся блоками. Все эти средства доступны только в AutoCAD.

Атрибуты можно также использовать для записи текста, относящегося к блоку. Распространенный пример использования атрибутов — запись информации о блоке (имя чертежа, децимальный номер, дата, масштаб, учетный номер, чертежник и т.д.). Если извлекать данные об объекте не требуется, атрибуты можно использовать, чтобы облегчить вставку текста в блок штампа. Кроме того, в атрибуты можно добавлять текстовые поля (только в AutoCAD). 


Использование атрибутов имеет некоторые ограничения. Подключать атрибуты можно только к блокам. Чтобы обойти это ограничение, можно создать фиктивный блок, состоящий только из атрибутов. Процесс извлечения данных при этом покажется несколько искусственным, но несмотря на ограничения атрибуты хорошо подходят для хранения небольшой базы данных и для размещения текста.
Создание определений атрибутов. Прежде чем начать работу с атрибутами, следует начертить отдельные объекты, из которых будет сформирован блок. Если блок уже существует, его нужно расчленить, добавить атрибуты, а затем определить блок заново.
Исключение составляют случаи, когда атрибуты определяются без создания блока. Такие атрибуты могут понадобиться для извлечения информации, относящейся ко всему чертежу.
После создания объектов выберите команду меню Draw>Block>Define Attributes (Рисо​ва​ние>Блок>Определение атрибутов). Будет запущена команда окно Attribute Definition (Определение атрибута), показанное на рис. 2.1.
Приборная панель содержит контрольную панель Block Attributes. По умолчанию она скрыта. Чтобы вывести ее, щелкните правой кнопкой мыши на приборной панели и выберите в контекстном меню команду Control Panels>Block Attri​bu​tes (Контрольные панели>Атрибуты блоков). Для создания определения атрибута щелкните на кнопке Define Attributes (Определение атрибутов), расположенной на контрольной панели Block Attributes приборной панели.
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Рис. 2.1. Диалоговое окно Attribute Definition
Группа Mode. В группе Mode (Режим) диалогового окна Attribute Definition устанавливаются параметры атрибута, приведенные в табл. 2.1.
	Флажок
	Описание

	Invisible (Невидимый)
	Установленное значение атрибута не отображается на чертеже. Режим используется для атрибутов, значения которых необходимо передавать в базу данных и не показывать на чертеже. Примерами могут служить номера модели, цены, даты покупки и т.п. Если атрибуты используются для вставки текста на чертеж, то этот режим не применяется

	Constant (Постоянный)
	Атрибут получает фиксированное значение. Программа автоматически вставляет заданное значение (оно задается в группе Attribute) и не запрашивает его. Этот режим может понадобиться, например, для первых трех цифр телефонного номера служащего, которые никогда не изменяются. Постоянные значения атрибутов редактировать нельзя

	Verify (Контро​лируемый)
	При вставке блока выполняется проверка правильности значения. Режим используется, если имеется предустановленное значение по умолчанию

	Preset (Пред​установленный)
	Атрибут автоматически получает значение по умолчанию. Например, если наиболее вероятным производителем является компания American Interiors, то ее название можно указать как предустановленное значение. При вставке блока предустановленное значение вставляется без вмешательства пользователя; вводить его понадобится, только если необходимое значение атрибута отличается от предустановленного (при этом системной переменной ATTDIA должно быть присвоено значение 1, чтобы появилось приглашение изменить значение атрибута, как объясняется далее в главе)

	Lock Position (Блокировка позиции)
	Блокировка положения атрибута относительно блока. При вставке блока с атрибутами блокированные атрибуты не имеют своих ручек и не могут перемещаться независимо от блока. Разблокированные атрибуты имеют ручки и могут перемещаться отдельно от блока. Чтобы включить атрибут в набор выделения в действии динамического блока, нужно заблокировать его. Перемещать его можно будет с помощью команды -ATTEDIT

	Mulitple Lines (Много строк)
	Атрибут может содержать несколько строк текста. При установке флажка справа от текстового поля Default (По умолчанию) появится кнопка с троеточием, с помощью которой можно открыть упрощенный редактор многострочного текста (рис. 18.32). Вводимый текст становится текстом по умолчанию. Его можно изменить при вставке блока. Затем можно задать ширину рамки в группе Text settings (Параметры текста)


Табл. 2.1. Режимы атрибута
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Рис. 2.2. Упрощенный редактор многострочного текста, используемый для форматирования многострочных атрибутов
Теперь атрибут может содержать более одной строки текста. Текст можно отформатировать в упрощенном редакторе многострочного текста, предоставляющем больше параметров форматирования, чем редактор однострочных атрибутов. Для вывода дополнительных параметров форматирования щелкните правой кнопкой мыши в редакторе.

Для форматирования многострочных атрибутов можно также использовать не упрощенный, а полнофункциональный редактор многострочного текста. Для этого присвойте системной переменной ATTIPE значение 1. Если важна совместимость с предыдущими версиями AutoCAD и AutoCAD LT, оставьте значение 0. В противном случае предыдущие версии будут выводить атрибуты неправильно.

Группа Attribute. В поле Tag (Имя) группы Attribute задается имя атрибута (другие названия — тег или дескриптор атрибута). Оно используется при извлечении атрибутов. Имя атрибута соответствует полю в базе данных. Если данные импортируются, например, в электронную таблицу, то имена могут служить заголовками столбцов. Имя не должно содержать пробелов и восклицательных знаков. Оно автоматически преобразуется в верхний регистр.
В поле Prompt (Подсказка) вводится текстовая расшифровка имени. Подсказка используется при выводе запроса на значение атрибута. Например, если имя равно PUR_DATA, то можно определить подсказку как Date Purchased (Дата покупки).

В поле Default устанавливается значение по умолчанию. Его можно использовать, если значения часто повторяются. Чтобы вставить текстовое поле, щелкните на кнопке Insert Field (Вставить поле) и выберите его имя в диалоговом окне Field (Текстовое поле), как описано в главе 13. При вставке блока вам будет предложено задать значение; в ответ вы можете либо задать значение текстового поля, либо изменить его.

Если установить флажок Multiple lines (Много строк), поле Default будет недоступным. Вместо него можно использовать кнопку с троеточием. Щелкните на ней и введите значение по умолчанию в упрощенном редакторе многострочного текста.

Значение по умолчанию можно также использовать для указания формата, которого следует придерживаться при вводе значения. Например, это значение можно установить равным dd/mm/yy, чтобы пользователь увидел, в каком фор​мате вводить дату.

Группа Text Settings. Группа Text Settings (Параметры текста) используется для форматирования текста. Выберите необходимые параметры в раскрывающихся списках Justification (Выравнивание) и Text style (Текстовый стиль). Если атрибут не аннотированный, то при установке высоты учитывайте масштаб печати или видового экрана. Можно также задать угол поворота текста в поле Rotation (Поворот).
Чтобы атрибут был аннотированным, установите флажок Annotative. Тогда атрибут будет автоматически настраиваться на основе масштаба видового экрана или печати. Аннотирование текстов рассматривается в главах 13 и 17.

Если установить флажок Multiple lines, будет доступным текстовое поле Boundary width (Ширина рамки). Однако ширину рамки легче задать, перетаскивая стрелочку на линейке в упрощенном редакторе многострочного текста.

Группа Insertion Point. В группе Insertion Point (Точка вставки) установите флажок Specify On-screen (Задать на экране), чтобы указать точку вставки на чертеже. Если снять флажок, точку вставки можно будет задать путем ввода координат. При использовании атрибутов для размещения текста в блоке штампа или в каком-либо расписании точка вставки весьма важна. При вставке невидимого атрибута точка вставки неважна, распложите его просто рядом с блоком. При создании нескольких атрибутов для одного блока разместите их аккуратно, например в одной колонке. Заполнив диалоговое окно Attribute Definition, щелкните на кнопке OK. Если задано указание точки вставки на экране, щелкните в нужной точке чертежа.
Если вы создаете атрибут для таблицы или обозначений электрической схемы, то координаты точки вставки (0,0) нежелательны. Лучше, если точка вставки будет рядом с блоком. Если вы забыли указать точку и щелкнули на кнопке OK, чтобы закрыть диалоговое окно, то для точки вставки автоматически будут установлены координаты (0,0). Если точка (0,0) не видна на экране, то вы не увидите атрибут — создается впечатление, что он исчез! Тогда щелкните на кнопке Undo (Отменить) стандартной панели инструментов и создайте новый атрибут с верным расположением или переместите атрибут, как объясняется далее в главе.

После определения атрибута будет установлен флажок Align below previous attribute (Выравнивание по предыдущему атрибуту). Оставьте его установленным, если хотите разместить следующий атрибут под предыдущим.

Теперь пора удостовериться в том, что атрибуты вышли такими, как планировалось. Их определение можно изменить перед размещением в блоке одним из двух способов.

-     Щелкните на кнопке Properties (Свойства) стандартной панели инструментов (или нажмите клавиши <Ctrl+1>) и отредактируйте свойства атрибута — имя, значение, подсказку и режимы.

-     Выберите команду меню Modify>Text (Редактирование>Текст) и отредактируйте имя, подсказку и значение по умолчанию (команда DDEDIT).

Для создания нескольких блоков с одинаковыми атрибутами можно скопировать только атрибуты, изменить их, как описано выше, поместить около других объектов, а затем создать блоки. Таким образом, вам не придется вновь определять все атрибуты с нуля.
Редактирование атрибутов. Перед созданием блока можно изменять свойства тегов атрибутов с помощью палитры свойств или команды DDEDIT (чтобы запустить ее, выберите команду меню Modify>Object>Text>Edit). Если блок уже создан, то в AutoCAD воспользуйтесь диалоговым окном Block Attribute Manager (Менеджер атрибутов блока). С его помощью можно управлять всеми значениями и свойствами атрибутов блока. В AutoCAD LT используйте диалоговое окно Edit Attribute (Редактирование атрибутов), которое активизируется командой ATTEDIT.
Редактирование свойств атрибута в AutoCAD
Если вы уже вставили блок и присвоили значения всем его атрибутам, то изменить сможете только следующее:
· последовательность вывода подсказок атрибутов;
· теги и подсказки;
· видимость атрибутов;

· параметры текста;
· свойства (слой, типы линий, цвет, толщина линий и стиль печати);

· значения.

После внесения изменений можно обновить все блоки чертежа, чтобы отразить в них эти изменения.

Чтобы запустить команду BATTMAN, которая активизирует диалоговое окно Block Attribute Manager (рис. 2.3), выберите команду Modify>Object>Attribute>Block Attribute Manager (Редактирование>Объект>Атрибут>Менеджер атрибутов блока).
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Рис. 2.3. Окно Block Attribute Manager
В раскрывающемся списке Block диалогового окна Block Attribute Manager выделите блок, значения атрибутов которого вы хотите изменить. Можете также щелкнуть на кнопке Select Block (Выбор блока) и выбрать блок непосредственно на чертеже. В диалоговом окне Block Attribute Manager можно выполнить ряд операций:
· Изменение последовательности вывода подсказок атрибутов при вставке блока с атрибутами. Выберите в списке окна Block Attribute Manager любой атрибут и щелк​ните либо на кнопке Move Down (Переместить вниз), либо на кнопке Move Up (Пере​местить вверх). Повторяйте эту операцию до тех пор, пока перемещаемый атрибут не займет место, которое вы для него определили.
· Удаление атрибута. Чтобы удалить атрибут, выделите его и щелкните на кнопке Delete (Удалить).
· Задание атрибутов, свойства которых будут перечислены в окне Block Attribute Manager. Щелкните на кнопке Settings (Параметры). В открывшемся диалоговом коне Settings установите флажки напротив всех свойств, которые вы хотите включить в список. Например, можно включить в список столбцы для слоя, текстового стиля и цвета. Щелкните на кнопке OK.

При добавлении свойств в список диалогового окна Block Attribute Manager при​дется увеличить его размеры, чтобы были видны все столбцы.

· Редактирование атрибутов, включая изменение подсказок, значений по умолчанию, режима отображения текста и свойств. Щелкните на кнопке Edit (Редактировать), чтобы активизировать диалоговое окно Edit Attribute (рис. 2.4).
· Обновление всех экземпляров блоков с целью отразить в них внесенные изменения. Щелкните на кнопке Sync (Синхронизировать). Обычно это следует делать после использования диалогового окна Edit Attribute. Изменения, затрагивающие последовательность вывода и режимы атрибутов, без этой операции влияют только на процесс вставки новых блоков, в то же время данная операция полностью синхронизирует существующие блоки с новыми.
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Рис. 2.4. Диалоговое окно Edit Attribute
В диалоговом окне Edit Attribute, которое имеет три вкладки, можно изменить любое свойство атрибута.

· Attribute (Атрибут). В этой вкладке можно изменить режим и свойства атрибута. Например, в группе Mode (Режим) можно изменить состояние видимости атрибута, а в группе Data (Данные) — тег, подсказку и значение по умолчанию. Можете также применить текстовое поле. Для этого щелкните правой кнопкой мыши в поле Default и выберите в контекстном меню команду Insert Field (Вставка текстового поля).

· Text Options (Параметры текста). В этой вкладке можно изменить стиль, высоту, выравнивание и многие другие параметры текста.

· Properties (Свойства). В этой вкладке можно изменить слой, цвет, тип линий и другие свойства атрибута.

Закончив вносить изменения, щелкните на кнопке OK диалогового окна Edit Attribute, чтобы вернуться в окно Block Attribute Manager, а затем щелкните на кнопке OK этого окна, чтобы продолжить работу над чертежом. 

Программа Insrot вставляет блок с заданным углом поворота, но оставляет горизонтальное расположение атрибутов. Ее можно найти в каталоге \Software\Chapter 18\Insort.

Иногда возникает необходимость изменить значение какого-то атрибута. Например, вы могли ввести неправильную дату покупки или, что тоже возможно, изменился шифр какого-то компонента. Тогда выберите команду Modify>Object>Attribute>Single (Редактирова​ние>
Объект>Атрибут>Одиночный) и выделите блок, содержащий нужный атрибут. Можете также ввести в командной строке EATTEDIT. Активизируется окно редактора Enhanced Attribute Editor (Расширенный редактор атрибутов), которое показано на рис. 2.5.
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Рис. 2.5. Окно редактора Enhanced Attribute Editor
Нетрудно заметить, что этот редактор похож на диалоговое окно Edit Attribute. Однако во вкладке Attribute (Атрибут) редактора можно изменять значения атрибутов, чего нельзя делать в диалоговом окне Edit Attribute. Чтобы изменить значение атрибута, следует выделить этот атрибут и ввести его новое значение в поле Value (Значение). Можно также щелкнуть правой кнопкой мыши в поле Value и выбрать команду Insert Field (Вставить текстовое поле). Текстовые поля описаны в главе 13.

Вкладки Text Options (Параметры текста) и Properties (Свойства) ничем не отличаются от аналогичных вкладок диалогового окна Edit Attribute.

После расчленения блока, имеющего значения атрибута, эти значения будут утеряны.

Редактирование свойств атрибута в AutoCAD. В AutoCAD можно изменять значения атрибутов с помощью команды ATTEDIT, которая активизирует диалоговое окно Edit Attributes (Редактирование атрибутов), показанное на рис. 2.6.
Если блок имеет несколько атрибутов и вы хотите изменить их все по порядку, то быстрее и проще всего использовать именно диалоговое окно Edit Attributes. Для перехода к следующему атрибуту просто нажимайте клавишу <Tab>.

Программа AutoCAD LT предлагает единственный способ изменения свойств атрибутов. Расчлените блок и дважды щелкните на атрибуте. Произойдет запуск команды DDEDIT и активизируется диалоговое окно Edit Attribute Definition (Редактирование определений атрибутов). В нем можно изменить тег, приглашение и значение по умолчанию. Затем переопределите блок. Этот метод работает и в AutoCAD, однако редактировать свойства атрибутов значительно легче с помощью диалогового окна Block Attribute Manager, как описано выше.

Чтобы редактировать атрибуты в командной строке, введите -attedit. В ответ на приглашение Edit attributes one at time? [Yes/No]<Y>: (Редактировать атрибуты по одному? [Да/Нет]) выберите Yes. Затем можно изменять значения и свойства атрибута, например его положение, текстовый стиль, цвет и т.д.
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Рис. 2.6. Диалоговое окно Edit Attributes
Если вы создали невидимый атрибут, то редактировать его вы не сможете, так как просто не сможете его выделить. Для одновременного изменения состояния видимости всех атрибутов чертежа используется команда ATTDISP. Чтобы запустить ее, выберите в главном меню команду View>Display>Attribute Display (Вид>Вывод>Вывод атрибута) и задайте один из перечисленных ниже режимов. В меню активный режим отмечен флажком.

· Normal (Обычный). Атрибуты, созданные как видимые, в текущий момент являются видимыми, а атрибуты, созданные как невидимые, в текущий момент являются невидимыми. Этот режим активен по умолчанию.

· On. Все атрибуты являются видимыми.

· Off. Все атрибуты невидимы.

При изменении текущих параметров программа регенерирует чертеж.
2.2. Практическое применение теоретического вопроса.

2.2.1.Создание атрибутов

1. На чертеже изображен увеличенный план офиса, на экране виден только один кабинет. Файл содержит вставленный комплект офисной мебели (рис. 2.7).

2. Щелкаем на кнопке Explode, расположенной на панели инструментов Modify или на приборной панели. Выделяем мебель в офисе. Блок содержит вложенные блоки. Выделяем стул и снова проводим расчленение на составляющие объекты.

3. Выбераем команду Draw>Block>Define Attributes (Рисование>Блок>Определение атрибутов). В группе Mode (Режим) диалогового окна Attribute definition (Опреде​ле​ние атрибута) установливаем флажок Invisible (Невидимый).

4. В группе Attribute (Атрибут) в поле имени вводим mfr, в поле подсказки — Manufacturer, в поле значения — American Office Furniture.
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Рис. 2.7. Помещение офиса с комплектом офисной мебели

5. Параметры группы Text settings не изменяем. Установливаем флажок Specify on-screen и щелкаем на кнопке OK. Указываем точку 1, руководствуясь рис. 2.7.

6. Повторяем команду ATTDEF. Установливаем флажок Align below previous attribute (Выравнивание по предыдущему атрибуту). Введим в поле имени фразу pur_date, в поле подсказки — Date purchased, а в поле значения — 3/91.

7. Щелкаем на кнопке OK.

8. Щелкаем на кнопке Make Block, расположенной на панели инструментов Draw или на приборной панели. В поле Name вводим armchair. Щелкаем на кнопке Select Objects (Выделить объекты). Выделяем полностью все кресло и два атрибута. Завершаем выделение. В диалоговом окне появилось сообщение о том, что найдено 18 объектов. Щелкаем на кнопке Pick Point. Используем объектную привязку конечной точки, чтобы указать точку 2 в качестве базовой. Установите переключатель Delete (Удалить). Щелкните на кнопке OK.

9. На запрос, желаете ли вы переопределить блок, отвечаем Yes. (Программа выводит это приглашение, поскольку на чертеже уже есть блок с таким же именем.)

10. Сохраняем чертеж. 
11. При переопределении блока обновляются только его геометрические параметры, а не атрибуты. Следовательно, если к блоку были добавлены определения атрибутов, то эти атрибуты будут передаваться только новым вставляемым блокам. Существующие блоки не получат новых определений атрибутов. Чтобы обновить существующие блоки (добавить в них текущие определения атрибутов), применяем команду ATTSYNC (Синхронизация атрибутов). 
2.3.  Проектирование в AutoCAD 2D модели детали. 

Даны 2 вида детали:
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Рис. 2.8. Два вида отображения детали.
В данной работе нам задано два вида детали. С помощью программы САПР AutoCad 2008 следует построить третий вид. Для начала требуется создать слои. На панели инструментов Layers нажимаем кнопку Layer Properties Manager. Откроется окно в котором и будут создаваться слои при нажатии кнопки New Layer.

[image: image14.png]et P a
&% B vEXY es
>[5 vome o Fre L Unetype Lneweiht_ Trams.. Fots.. P,

= 9 o o Continuo. -0 =]

|z Defpoints Q o &£ Continuo. o

| Banomoratensraie mwant Q o &£ Continuo. 0 =

|z Banoworatensmwie mamocei |9 Tt o Continuo. 0 =

|l rimam oceit Q o &£ Continuo. 0 =
gl = rmm oces amerpmn Q o &£ ACAD_IS. o =Y

[ P ——— Q o &£ HIDDENZ 0 =

&| |l oo Q o &£ Continuo. 0 =

o | P ———y— Q o &£ Continuo. 0 =

b= | S y— Q o &£ Continuo. o =Y

g |l& cema Q o &£ Continuo. 0 =

8| |lo wremn Q o & Continuo. .0 =

H

8> 5

é -] P 2 loyors Geplyed of 12kl lyers





Рис. 2.9. Слои в Layer Properties Manager.

После создания слоев начинаем построение линий осей, а так же вспомогательных линий. Линии эти строятся с помощью команды Construction Line. После этого начинаем построение самой детали. Выполняется это с помощью команд Line, Rectangle, Circle на панели инструментов Draw.
Далее нам требуется построить линии осей симметрии, а также невидимые линии. Линии осей симметрии строятся штрих пунктирной линией, а невидимые – пунктирной. Для этого требуется открыть окно Lauer Properties Manager > Linetype. Открывается окно Select Linetype (рис. 2.10). 
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Рис. 2.10. Чертёж детали в двух проекциях.
Далее при помощи проекционных связей строим третий вид детали.
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Рис. 2.11. Три вида детали
Для завершения работы остается обозначить все размеры на чертеже. Для этого в меню Dimension выбираем команду Linear, Diameter  и наносим все размеры.
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Рис. 2.12. Готовый чертёж детали.

Таким образом мы выполнили построение детали в трех проекциях и  получили готовый чертёж детали, который отображает геометрическую форму детали и её размеры.
2.4. Проектирование 3d модели и выполнение разреза в AutoCad. 

Нам требуется смоделировать деталь в трехмерном пространстве. Для этого используем примитивы cylinder и box, wedge. Для объединения частей детали используем  команду union, а для вычитания subtract.
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Рис. 2.13. Модель детали без выреза.
После этого необходимо выполнить вырез четверти. Для этого при помощи команды slice деталь разрезается по осям симметрии сначала на две части, потом одну из полученных половин разрезаем ещё на две части. Выполнив разрез удаляем одну из четвертей, а вторую при помощи команды union объединяем с остальной частью детали. В результате получаем трехмерную модели детали с вырезом четверти. 

Для завершения модели остаётся только добавить штриховку. При помощи примитива pline обводим плоскости полученные при рассечении детали секущей плоскостью. Затем при помощи инструмента hatch добавляем штриховку.
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Рис. 2.14. Модель детали с вырезом.
Создаём видовые экраны. Для этого заходим в layout и  при помощи инструмента vports располагаем необходимые видовые экраны.
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Рис. 2.15. Пространство листа №1.
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Рис. 2.16. Пространство листа №2.

Таким образом мы получили 3d модель детали с вырезом и подготовили её для печати.
2.5. Выполнение 3d модели реального объекта
В данной расчетно-графической работе необходимо выполнить 3d модель собственного мобильного телефона. 
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Рис. 2.17. Мобильный телефон
Для моделирования своего телефона нужно создать определенные слоя, которые потребуются для работы.
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Рис. 2.18. Окно Layer Properties Manager
Далее приступаем к созданию трехмерной модели телефона. Для этого воспользуемся такими примитивами как Spline и Polyline которыми мы обведём все контуры телефона, включая сам корпус, кнопки, экран, клавиатуру, сим карту, надписи и символы, после чего используя Loft или Extrude вытягиваем 2D контуры телефона в 3D, после чего получим все нужные нам детали телефона. После этого, используя функции Union, Subtract и Intersect мы получим готовый телефон с совпадающими деталями, без наложения друг на друга.
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Рис. 2.19. Телефон вид сверху
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Рис. 2.20. Телефон вид снизу

Таким образом выполнив все необходимые операции мы получили 3d модель телефона Samsung x700.
2.4. Проектирование в AutoCAD 3D модели детали с настройкой параметров визуализации 

Необходимо создать 3D модель детали (рис. 2.24) с настройкой параметров визуализации.
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Рис. 2.21. Деталь, выбранная согласно варианту.
Выполним проектирование детали при помощи стандартных примитивов AutoCAD (Polyline, Cylinder, Box) а также при помощи команд Extrude и Subtract. 
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Рис. 2.22. 3D модель детали.


По заданию, выполненная деталь, является указателем, поэтому можно предположить, что она изготовлена из пластика. Выбираем материал, который соответствует пластику. Накладываем материал при помощи команды Materials. В результате получаем деталь покрытую материалом (рис. 2.23).
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Рис. 2.23. Модель с наложенным материалом

Далее добавляем источники освещения. Для этого воспользуемся командой Pointlight и зададим необходимые параметры освещения, такие как интенсивность и цвет освещения. Добавим несколько источников освещения с разных сторон для лучшего отображения детали (рис. 2.24).
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Рис. 2.24. Расположение источников света


В качестве фонового рисунка сделаем поверхность и наложим на неё текстуру. Модель расположим на поверхности фонового рисунка.

После настройки всех параметров визуализации можно приступить к рендерингу. Для этого настроем параметры рендеринга в соответствующей вкладке на Render. Укажем наивысшее качество рендеринга – Presentation и выберем разрешение 1024х768. После этого запускаем рендинг. В результате получаем растровое изображение детали с применёнными параметрами визуализации (рис. 2.25).
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Рис. 2.25. Деталь после рендеринга


Таким образом мы выполнили создание 3D модели детали с настройкой параметров визуализации. Среда AutoCAD имеет все необходимые инструменты для настройки параметров визуализации.

2.5. Настройка визуализации реального объекта

Настроем параметры визуализации 3D модели мобильного телефона. Для этого необходимо задать подходящие материалы каждому объекту модели, настроить параметры отражения и прозрачности. Данные операции выполним при помощи инструмента Materials. В результате получим модель телефона с заданными материалами, которая после рендеринга приобретает более реалистичный вид (рис. 2.26).
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Рис. 2.26. Модель телефона с заданными материалами


В качестве фона зададим поверхность и назначим ей текстуру пластика. Для этого воспользуемся примитивом Planar и инструментом Materials. 
Далее необходимо задать освещение, которое бы способствовало максимально реалистичному изображению детали. Что бы достигнуть поставленной цели создадим разные источники освещения с разной интенсивностью и расположим их с разных сторон от модели (рис. 2.27). Для этого воспользуемся командами pointlight и spotlight.
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Рис. 2.27. Модель с расставленными источниками света
Проведя рендеринг модели получим реалистичное изображение телефона (рис. 2.28).
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Рис. 2.28. Телефон с закрытым корпусом


В результате проделанной работы мы получили 3D модель телефона с настроенными параметрами визуализации. После рендеринга получили реалистичное изображение телефона. Таким образом можно сделать вывод, что AutoCAD содержит все необходимые инструменты для настройки визуализации моделей.
ВЫВОДЫ РАЗДЕЛА 2
1) Выполнив 2d чертеж в AutoCAD можно сделать вывод, что данный САПР хорошо подходит для выполнения данного вида работ и содержит все необходимые инструменты. При этом процесс создания двухмерного чертежа достаточно прост и не требует больших затрат времени, это связано с удобством использования инструментов и наличием достаточного количества примитивов. 

2) Создание 3d чертежа детали в AutoCAD также достаточно несложный процесс. Разработчики предусмотрели все необходимые инструменты, которые могут понадобиться при построении трехмерной модели детали. Так же предусмотрены удобные средства перехода между различными видами детали, что особенно помогает при создании сложных трехмерных объектов.
3) Моделирование реальных сложных объектов в AutoCAD намного более сложный процесс. Не все средства системы приспособлены к такому виду работ. Для проектирование таких моделей лучше подойдёт САПР Unigraphics. Но при наличии некоторого опыта моделирования в AutoCAD, можно успешно выполнять сложные модели в данной системе.
4) Система AutoCAD содержит все необходимые инструменты для визуализации, такие как освещение, материалы, текстуры, рендеринг. Данные инструменты удобны для использования и удовлетворяют потребности большинства пользователей.
ВЫВОДЫ

В процессе выполнения данной расчетно-графической работы были рассмотрены возможности САПР AutoCAD для создания 2d и 3d моделей детали с выполнением выреза четверти. Инструменты 
входящие в САПР AutoCAD подходят для выполнения поставленной задачи. 


Кроме САПР AutoCAD существует множество программ, которые могут успешно справляться с задачами моделирования, но не одна из них не является настолько распространенной, как AutoCAD. Это связано с тем, что система AutoCAD имеет ряд преимуществ:

· Большое количество литературы и интернет ресурсов

· Удобный пользовательский интерфейс

· Простота освоения и использования

· Удобные инструменты для печати документов
AutoCAD хорошо подходит для создания 2d моделей и содержит все необходимые инструменты. При этом процесс создания двухмерного чертежа достаточно прост и не требует больших затрат времени, это связано с удобством использования инструментов и наличием достаточного количества примитивов. 
Создание 3d чертежа детали в AutoCAD также достаточно несложный процесс. Разработчики предусмотрели все необходимые инструменты, которые могут понадобиться при построении трехмерной модели детали. Так же предусмотрены удобные средства перехода между различными видами детали, что особенно помогает при создании сложных трехмерных объектов.
Моделирование реальных сложных объектов в AutoCAD намного более сложный процесс. Не все средства системы приспособлены к такому виду работ. Для проектирование таких моделей лучше подойдёт САПР Unigraphics. Но при наличии некоторого опыта моделирования в AutoCAD, можно успешно выполнять сложные модели в данной системе.
Система AutoCAD содержит все необходимые инструменты для визуализации, такие как освещение, материалы, текстуры, рендеринг. Данные инструменты удобны для использования и удовлетворяют потребности большинства пользователей.
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